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Typographic Conventions

Table 1

N

<Example>

Angle brackets indicate that you replace these words or characters with appropriate entries
to make entries in the system, for example, “Enter your <User Name>".

b Example » Example 3

Arrows separating the parts of a navigation path, for example, menu options

Example

Emphasized words or expressions

Example

Words or characters that you enter in the system exactly as they appear in the
documentation

Www.sap.com

Textual cross-references to an internet address

/example Quicklinks added to the internet address of a homepage to enable quick access to specific
content on the Web
123456 Hyperlink to an SAP Note, for example, SAP Note 123456
Example e  Words or characters quoted from the screen. These include field labels, screen titles,
pushbutton labels, menu names, and menu options.
® (Cross-references to other documentation or published works
Example ®  Qutput onthe screen following a user action, for example, messages
®  Source code or syntax quoted directly from a program
® File and directory names and their paths, names of variables and parameters, and
names of installation, upgrade, and database tools
EXAMPLE Technical names of system objects. These include report names, program names,

transaction codes, database table names, and key concepts of a programming language
when they are surrounded by body text, for example, SELECT and INCLUDE

EXAMPLE Keys on the keyboard
CUSTOMER
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Document History

A Caution

Before you start the implementation, make sure you have the latest version of this document. You can find the
latest version at the following location: service.sap.com/instguides.

The following table provides an overview of the most important document changes.

Table 2
14 2015-04-30 Formal revision for general availability
1.3 2014-11-11 Revision for SAP Event Management 9.2
11 2013-05-09 Formal revision for general availability
1.0 2012-09-27 Initial version
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1 Getting Started

Caution

This guide does not replace the daily operations handbook that we recommend customers create for their
specific production operations.

Designing, implementing, and running your SAP applications at peak performance 24 hours a day has never been
more vital for your business success than now.

This guide provides a starting point for managing your SAP applications, and maintaining and running them
optimally. It contains specific information for various tasks and lists the tools that you can use to implement them.
This guide also provides references to the documentation required for these tasks, so you need other guides such
as the Master Guide, Technical Infrastructure Guide, and SAP Library.

1.1 Global Definitions

SAP Application:

An SAP application is an SAP software solution that serves a specific business area such as ERP, CRM, PLM, SRM,
and SCM.

Business Scenario:

From a microeconomic perspective, a business scenario is a cycle that consists of several different
interconnected logical processes in time. Typically, a business scenario includes several company departments
and involves other business partners. From a technical point of view, a business scenario needs at least one SAP
application (SAP ERP, SAP SCM, or others) for each cycle, and possibly other third-party systems. A business
scenario is a unit that can be implemented separately and reflects the customer’s prospective course of business.

Component:

A component is the smallest individual unit considered in the Solution Development Lifecycle; components are
separately produced, delivered, installed, and maintained.

1.2 Important SAP Notes

Caution

Check regularly to see which SAP Notes are available for the Application Operations Guide.

CUSTOMER
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Table 3: Important SAP Notes

617547 RZ20: Sending alerts as mail and SMS None

2050605 Installation Only relevant when installing SAP Event
Management 9.2 as an add-on
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2 Technical System Landscape

2.1 Scenario/Component Matrix

For information about the software components required for specific processes and scenarios, see the Master
Guide for SAP Event Management on SAP Service Marketplace at [ service.sap.com//instguides 1. Check also
possible corrections to the Master Guide in SAP Notes.

2.2 Related Documentation

For more information about the technical system landscape, see the following table:

Table 4

Application- and Industry-specific
Components such as SAP Financials
and SAP Retail

Master Guide

service.sap.com/instguides

Technology Components such as SAP
NetWeaver Application Server

Master Guide

service.sap.com/instguides

Sizing

Quick Sizing Document

| service.sap.com/sizing » Solution
Life-Cycle Management » Hardware
Sizing ¥ Sizing Guidelines ¥ Solutions &
Platforms » SAP Business Suite » SAP
SCM » Sizing SAP Event Management 3

You must consider the sizing
requirements for SAP Event
Management in addition to the sizing
requirements for the underlying
application system, for example, SAP
Supply Chain Management (SAP SCM)
or SAP ERP.

Technical Configuration

help.sap.com/netweaver, select the
version of SAP NetWeaver, and choose
Security Information.

SAP Event Management 9.2
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High Availability

help.sap.com/netweaver, select the
version of SAP NetWeaver, and choose
Security Information. [ SAP NetWeaver
Library: Function-Oriented View »
Solution Life Cycle Management » SAP
High Availability 3

Security

Technical Infrastructure

service.sap.com/security
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3 Monitoring of SAP Event Management

In the management of SAP Technology, monitoring is an essential task. A section has therefore been devoted
solely to this subject.

For more information about the underlying technology, see SAP Library for SAP NetWeaver on SAP Help portal at
help.sap.com/netweaver, and select the version of SAP NetWeaver. In SAP Library, choose ¥ Administration
Information » Technical Operations for SAP NetWeaver 1.

3.1 Alert Monitoring with CCMS

Proactive, automated monitoring is the basis for ensuring reliable operations for your SAP system environment.
SAP provides you with the infrastructure and recommendations you need to set up alert monitoring, to recognize
critical situations for SAP Event Management as quickly as possible.

3.11 CCMS Monitoring Installation and Setup

Procedure

The SAP Event Management monitor is an SAP Event Management-specific collection of functions, which displays
all the SAP Event Management messages on an overview screen, for example.

1 Note

We recommend that you connect SAP Event Management to the Computing Center Management System
(CCMS) only if you have appropriate knowledge of Computing Center Management.

To use the specific SAP Event Management monitor in the Computing Center Management System (CCMS) you
must fulfill the following prerequisites:

You have executed reports [ /SAPTRX/SLGI_LINK Jand |r /SAPTRX/SCHEDULE_EM_JOBS_NODE 3 once
before calling the SAP Event Management monitor. This is to ensure that the functions for evaluating the
application log and scheduling background jobs relevant to Supply Chain Event Management (SCEM) appear in
the choice of functions for the SAP Event Management monitor.

1 Note

If you restart the system, you must run these two reports again.

You have scheduled the respective background jobs for each client in which you want to set the monitoring
functions specific to SAP Event Management in the CCMS. The system displays the background jobs in the dialog
structure of the SAP Event Management monitor.

CUSTOMER
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Table 5

/SAPTRX/COLLECT_LOCKED_EH

Number of locked event handlers in the desired client

/SAPTRX/COLLECT_LOCKED_EHSETS

Number of locked event handler sets in the desired client

/SAPTRX/COLLECT_UNPROC_EVMSG

Number of unprocessed event messages in the desired client

1 Note

If you restart the system, schedule these background jobs again.

For more information, see SAP Library for SAP Event Management on SAP Help Portal at [ help.sap.com/
em92 1. In SAP Library, choose | SAP Event Management Infrastructure » Monitoring and Evaluation Processes »
Connection to the Computing Center Management System 1.

3.2 Detailed Monitoring and Tools for Problem and
Performance Analysis

3.21

SAP Event Management Analysis Tools

The technology of SAP Event Management is based on SAP NW AS. For information about technical problem
analysis (such as with a database, the operating system, or workload analysis), refer to the Application Operations
Guide for SAP NW AS. This guide covers only the differences and additional information specific to this solution.

The following monitors are available for analyzing SAP Event Management:

Table 6

/SAPTRX/EH_LIST

The event handler list provides details
about an event handler. The status of
events, event and error messages, and
status details are all contained in the
event handler list.

On the SAP Easy Access screen, choose
|k Event Management » Monitoring and
Lists » Event Handler List 1.

/SAPTRX/EVM_STATUS

The event message processing status
list shows system-generated messages
and points out if objects are processed
correctly in SAP Event Management.
The list reflects only data errors, not
business process issues.

On the SAP Easy Access screen, choose
|F Event Management » Monitoring and
Lists » Event Message Processing
Status List 1.

/SAPTRX/EE_MON

CUSTOMER

The expected event monitor is a report
that the system starts as a background
process. It checks if expected events
that should be reported within a specific
period of time have become overdue. If
the monitor discovers an overdue event,
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SAP Event Management reacts
according to the defined rules, for
example, by sending an e-mail in
response to the overdue events.

SAP delivers activities for the expected

event monitor, for example, comparing

two fields or activating an event handler
set.

/SAPTRX/LOCKED_PROC

This report triggers the subsequent
processing of event messages that
arrive for an event handler at a time
when SAP Event Management is locking
it.

Onthe SAP Easy Access screen, choose
|+ Event Management ¥

Administration » Processing Control ¥
Process Message for Locked Event
Handler 3.

/SAPTRX/LOCKED_PSET

This report reassigns an event handler
to an event handler set that SAP Event
Management is locking.

Onthe SAP Easy Access screen, choose
|» Event Management »

Administration ¥ Processing Control ¥
Process Locked Event Handler Sets 2.

/SAPTRX/EMJOBS

This report resends application object
data for event handlers.

When you update event handler data by
sending application objects to SAP
Event Management, it can be the case
that the event handler is locked by other
processing activities (for example,
momentary processing of an event
message).

To ensure that the event handler is
updated with the data when the locks
are released, the system temporarily
stores the data in a database table
(buffer).

This background job checks at regular
intervals if the database table contains
data. When the table contains data, it
tries to process it. If necessary, it
updates the event handler that was
previously locked with this data.

Onthe SAP Easy Access screen, choose
|» Event Management »

Administration » Processing Control ¥
Schedule Background Jobs for Event
Management 3.

3.2.11

Trace and Log Files

Trace files and log files are essential for analyzing problems.

An application log is available for both the application system and SAP Event Management.

SAP Event Management 9.2

Monitoring of SAP Event Management
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The application log documents messages, exceptions, and errors on both the application side and the SAP Event
Management side. This provides information about communication operations and problems that occur when
event handlers are created, event messages are processed, or information is queried.

You can analyze the logs or the corresponding messages according to different thematic areas and gain more
detailed information on the messages.

The application log in the application system provides you with an overview of all the activities relevant to an
application object as well as the appropriate event messages. You can reduce the memory space for the
application log by deactivating it per business object.

The SAP Event Management application log provides you with an overview of all activities for an event handler,
and for its corresponding event messages, that are issued during event handler processing.

If you have appropriate authorizations, you can define the following when creating an event handler:
® The objects that are logged:

o Event handler creation

©  Event message processing

©  Updating data from an external source

® The level of detail the system should use when creating logs from high-level processes only, to individual
processes.

You can call the application log from both the event handler overview and the event handler detail overview.
For the application log in the SAP system, call transaction /SAPTRX/ASAPLOG.

For the SAP Event Management application log, on the SAP Easy Access screen, choose [F Event Management »
Administration » Logging » Application Log: Display Logs (SLGI) 1.

Use the following log object and subobjects for SAP Event Management in SLG1:

Table 7
SAPTRX APPSYS Application system
CONSCHECK Customizing consistency check
EVTMSG Event message processing
SUBSCRIPT Logs for EPCIS subscriptions
TRKOBJ Event handler creation/update/deletion

If you want to deactivate the application log in the application system, in Customizing for the SAP Basis Plug-In,
choose |F Integration with Other SAP Components » Event Management Interface » Define Application Interface »
Define Used Business Process Types, Application Object Types, and Event Types 1.

For more information about application logs, see SAP Library for SAP NetWeaver on SAP Help Portal at
help.sap.com/netweaver, and select the version of SAP NetWeaver. In SAP Library, choose [ SAP NetWeaver
Library: Function-Oriented View » Solution Life Cycle Management » Application Log (BC-SRV-BAL) 1.

The logging categories and tracing locations are available in the J2EE Engine and are valid for the SAP framework
for Java. Since SAP Event Management does not have a Java component, the logging categories and tracing
locations do not apply for it.
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3.2.1.2

Overview of Regularly-Used Jobs, Transactions, and
Monitoring Tasks

Table 8
Monitoring Object | Monitoring Monitor Monitoring Responsible Escalation
Transaction/Tool | Frequency Activity or Error Procedure
Handling
Procedure
Set up of /SAPTRX/ Once, before Schedule Program Contact
monitoring SLG1_LINK working with SAP | background job for | scheduling application
Event each client to be management support
Management (not | monitored in the
with CCMS) for the | CCMS
first time
Set up of /SAPTRX/ Once, before Schedule Program Contact
monitoring SCHEDULE EM working with SAP | background job for | scheduling application
_JOBS_NOE;E Event each client to be management support
Management (not | monitored in the
with CCMS) for the | CCMS
first time
Display application | /SAPTRX/ Daily Display the Program Contact
log in SAP Event ASAPLOG application login scheduling application
Management SAP Event management support
Management
Evaluation of Transaction SLG1 | Daily Evaluate the Program Contact
application log application login scheduling application
SAP Event management support
Management
Status of events /SAPTRX/ n.a. Display Application Contact
and error EH_LIST functionality management application
messages shown support
List to see if /SAPTRY/ n.a. Display Program Contact
objects are EVM_STATUS functionality scheduling application
processed management support
correctly. The list
reflects data errors
only, not business
process issues.
Inbound and Transaction Daily Status of the Program Contact software
outbound queue SMQ1/ SMQ2 inbound and scheduling monitoring team
monitoring outbound queues | management
CUSTOMER
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3.2.1.3 Interfaces

Interface monitors are essential for analyzing problems with interfaces such as RFC, IDoc, and HTTP.

SAP Event Management uses the standard tools available in SAP NW AS and does not require an application-
specific tool. For more information, see SAP Library for SAP NetWeaver on SAP Help Portal at help.sap.com/
netweaver, and select the version of SAP NetWeaver. In SAP Library, choose v Administration Information »
Technical Operations for SAP NetWeaver 1.

3.2.1.4 Data-Archiving Monitors

For the latest documentation about archiving and deleting objects in SAP Event Management, see SAP Library for
SAP Event Management on SAP Help Portal at |p help.sap.com/em92 1. In SAP Library, choose
| Administration » Archiving and Deleting 3.

If you no longer need event handlers, event messages, or event handler sets, you can either archive and delete
them, or delete them without previously archiving them. When you delete event handlers, event messages, or
event handler sets, SAP Event Management also deletes any existing change documents.

3.2.1.5 Fast-Growing Tables for SAP Event Management

The fastest growing tables depend on the number of parameters, rules, and expected events you have.
For event handlers, pay special attention to all tables beginning with prefix /SAPTRX/EH_*, for example:
e /SAPTRX/EH_INFO
e /SAPTRX/EH_EXPEV
e /SAPTRX/EH_EVMSG
If you use customer-specific extension tables, pay special attention to these tables.
For event messages it also depends on how the customer uses SAP Event Management.
If you use file attachments, pay special attention to all tables beginning with prefix /SAPTRX/EVM_*, for example:
e /SAPTRX/EVM_AFB
e /SAPTRX/EVM_AFC
On the application system side, pay special attention to the table /SAPTRX/AOTREF.

CUSTOMER
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4 Management of SAP Event Management
Technology

4.1 Administration Tools for Software Components

SAP provides you with an infrastructure to help your technical support consultants and system administrators
effectively manage all SAP components and complete all tasks related to technical administration and operation.

For more information about the underlying technology, see SAP Library for SAP NetWeaver on SAP Help Portal at
help.sap.com/netweaver, and select the version of SAP NetWeaver. In SAP Library, choose [ Administration
Information » Technical Operations for SAP NetWeaver 1.

4.2 Software Configuration

This section explains which components or scenarios used by this application are configurable, and which tools
are available for adjustments.

Component Configuration Tools

Table 9

Configuration Tool(s) Detailed Description

SAP Event Management Implementation Guide (IMG) The Implementation Guide is the
standard SAP tool for component
Customizing. To display the
implementation Guide (IMG) on the SAP
Easy Access screen choose |[F Tools »
Customizing » IMG ¥ Execute Project
(transaction SPRO) 1.

ABAP transaction SM59 To configure RFC connections on the
SAP Easy Access screen choose

|F Tools » Administration »
Administration » Network » RFC
Destinations (transaction SM59) 4.

ABAP transaction BD54 To define a unique identification for a
system in a network to distribute data,
start transaction BD54.

ABAP transaction SICF To maintain and activate the HTTP
service hierarchy on the SAP Easy
Access screen choose | Tools »

Administration » Administration »

CUSTOMER
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Configuration Tool(s) Detailed Description

Network » HTTP Service Hierarchy

Maintenance (transaction SICF) 1.
No technical configuration data is necessary. All technical configuration data that is required for running SAP
Event Management is part of SAP NetWeaver.

4.3 Backup, Restore, and Recovery

You need to back up your system landscape regularly to ensure that you can restore and recover it in case of
failure.

The backup and restore strategy for an SAP application consists of two parts:
® Backup and restore coverage for each component
® (Cross-system data dependencies and handling

The backup and restore strategy for your system landscape should not only take into account SAP systems, but
should be embedded in the overall business requirements and cover the entire process flow within your company.

In addition, the backup concept must cover disaster recovery processes such as loss of the data center due to
fire. The most important issue to consider in this context is ensuring that you do not lose backup devices with
normal data storage devices. You should separate storage locations.

Based on the type of application data that a component holds, SAP introduces a categorization scheme for
system components. This can be used to analyze the backup requirements of any system component, and to
easily determine an appropriate backup method for this component. The following table contains a component list
for your solution and the appropriate categories of system components for backup and recovery.

Table 10
Component Category Application Data Type Backup Method for
Application Data
SAP Event Management Orig./Repl. Database and log backup; file

system backup (full and/or
incremental)

4.3.1 Backup and Recovery of SAP NetWeaver Components

Procedure

For the backup and recovery concept for all other SAP NetWeaver components mentioned in this guide, such as
SAP Xl and SAP BI, see SAP Library for SAP NetWeaver on SAP Help portal at help.sap.com/netweaver, and
select the version of SAP NetWeaver. In SAP Library, choose |» Administration Information » Technical Operations
for SAP NetWeaver 1.
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4.4 System Copy

Homogeneous System Copy

For a homogeneous system copy for SAP Event Management, the standard procedures of SAP NetWeaver apply.

4.5 Periodic Tasks

45.1 Scheduled Periodic Tasks

In addition to the standard jobs mentioned in the Technical Operations for SAP NetWeaver in the SAP Library for
SAP NetWeaver, you need to schedule SCM-specific jobs in your SCM system and, where specified, in all

connected SAP systems.

Unless otherwise specified, you should run all jobs at times of minimal system activity, so as not to affect

performance or otherwise disrupt your daily operations.

Table 11: Standard, Housekeeping Jobs

Program Name/Task Recommended Frequency Detailed Description

Report /SAPTRX/EE_MONITOR

Every 2-5 minutes

Expected Events Monitor is a scheduled
background job that continuously
identifies expected events that are
overdue. If an event has exceeded the
expected date, the system

®  Updates the event status to
|+ Overdue 1.

® Creates an expected event
monitor procedure, for example,
alert notification is executed.

To schedule the background job, use
transaction /SAPTRX/EMJOBS, or on
the SAP Easy Access screen for SAP
Event Management, choose [F Event
Management » Administration »
Processing Control » Schedule
Background Jobs for Event
Management 3.

For more information, see SAP Library
for SAP Event Management on SAP
Help Portal at help.sap.com/em92. In
SAP Library, choosell SAP Event
Management Infrastructure » Event »
Expected Event Monitor 1.

Report /SAPTRX/
PROCESS_LOCKED_EHS

SAP Event Management 9.2

Management of SAP Event Management Technology

6 times aday

Processor of locked event handlers is a
scheduled regular job in transaction /
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Program Name/Task Recommended Frequency Detailed Description

saptrx/emjobs. For more information,
see SAP Note 656990.

Report /SAPTRX/ 6 times a day (when working with EH Processor of locked event handler sets is
PROCESS_LOCKED_SETS Sets) a scheduled regular job in transaction /
saptrx/emjobs. For more information,
see SAP Note 656990.

Report /SAPTRX/R_REPORT_AI_LOGS | 6 times a day Resend Application Object Data for
Event Handlers is a scheduled regular
jobin transaction /saptrx/emjobs. For
more information, see SAP Note

656990.
Report /SAPTRX/ 6 times a day Number of locked event handlers in the
COLLECT_LOCKED_EH desired client is a scheduled regular job

in transaction /saptrx/emjobs. For
more information, see SAP Note

656990.
Report /SAPTRX/ 6 times a day (when working with EH Number of locked event handler sets in
COLLECT_LOCKED_EHSETS sets) the desired client is a scheduled regular

job in transaction /saptrx/emjobs. For
more information, see SAP Note
656990.

4.6 Logging On and Load Balancing

SAP Event Management uses the standard functionality of SAP NetWeaver for logon and load balancing. For more
information, see SAP Developer Network (SDN) Community at www.sdn.sap.com/irj/sdn/netweaver.

For more information, see SAP Library for SAP NetWeaver on SAP Help portal athelp.sap.com/netweaver, and
select the version of SAP NetWeaver. In SAP Library, choose v Administration Information » Technical Operations
for SAP NetWeaver 1.

4.7 User Management

SAP Event Management uses the standard function of SAP NetWeaver for user management. For more
information, see SAP NetWeaver Security Guide on SAP Help Portal at help.sap.com/netweaver, select the
version of SAP NetWeaver, and choose Security Information. In the guide, [» User Administration and
Authentication 2.

For more information about user management in SAP Event Management, see SAP Event Management Security
Guide on SAP Service Marketplace at [¢ service.sap.com/securityguide » SAP Business Suite Applications » SAP
SCM » SAP Event Management 2.
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For an overview of the information necessary to operate SAP NetWeaver Identity Management, see the Solution
Operations Guide for SAP enhancement packe 2 for SAP NetWeaver Identity Management 7.0 on SAP Help Portal
at|p help.sap.com/nwidm 3.

4.8 Printing

SAP Event Management uses the standard SAP NetWeaver printing function. For more information, see SAP
Library for SAP NetWeaver on SAP Help portal at help.sap.com/netweaver, and select the version of SAP
NetWeaver. In SAP Library, choose [» SAP NetWeaver Library: Function-Oriented View » Application Server »
Application Server ABAP » Administration of Application Server ABAP » SAP Printing Guide (BC-CCM-PRN) 2.
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5 High Availablity

SAP Event Management is based on SAP NW AS. For high availability options, see SAP Library for SAP NetWeaver
on SAP Help portal at help.sap.com/netweaver, and select the version of SAP NetWeaver. In SAP Library, choose
I SAP NetWeaver Library: Function-Oriented View » Solution Lifecycle Management » High Availability 3.
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6 Software Change Management

Software Change Management standardizes and automates software distribution, maintenance, and testing
procedures for complex software landscapes and multiple software development platforms. These functions
support your project teams, development teams, and application support teams.

6.1 Transport and Change Management

For transport and change management issues, SAP Event Management uses the SAP NetWeaver procedures. For
more information about the transport and change system, see SAP Library for SAP NetWeaver on SAP Help portal
at help.sap.com/netweaver, and select the version of SAP NetWeaver. In SAP Library, choose [F SAP NetWeaver
Library: Function-Oriented View » Solution Lifecycle Management » Software Logistics 1.

6.2 Development Requests and Development Release
Management

SAP Event Management uses the standard SAP NetWeaver procedures. For more information, see SAP Library
for SAP NetWeaver on SAP Help portal at help.sap.com/netweaver, and select the version of SAP NetWeaver. In
SAP Library, choose ¢ Administration Information » Technical Operations for SAP NetWeaver 1.

6.3 Template Management

You can deploy Customizing settings by using Business Configuration Sets (BC Sets).

For more information, see SAP Library for SAP NetWeaver on SAP Help portal at help.sap.com/netweaver, and
select the version of SAP NetWeaver. In SAP Library, choose |» SAP NetWeaver Library: Function-Oriented View »
Solution Lifecycle Management » Customizing .

6.4 Quality Management and Test Management

You can use the SAP NetWeaver Development Infrastructure to learn about the different ways to test your
software changes.
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6.5 Support Packages and Patch Implementation

We recommend implementing Support Package (SP) Stacks, which are sets of support packages and patches for
the respective product version that must be used in the given combination. The technology for applying support
packages and patches has not changed.

You can find detailed information about the availability of SP Stacks on SAP Service Marketplace at
service.sap.com/sp-stacks.

Read the corresponding Release and Information Notes (RIN) before you apply any support packages or patches
from the selected SP Stack.

For more information about the implementation of support packages and possible side effects, see SAP Service
Marketplace at |y service.sap.com/patches » SAP Support Packages in Detail 3.

For information about the tools necessary to implement patches, see SAP Library for SAP NetWeaver on SAP
Help portal at help.sap.com/netweaver, and select the version of SAP NetWeaver. In SAP Library, choose | SAP
NetWeaver Library: Function-Oriented View » Solution Lifecycle Management » Software Logistics 1.

6.6 Release and Upgrade Management

For release and upgrade information for SAP Event Management, see the Master Guide and the Upgrade Master
Guide for SAP Event Management on SAP Service Marketplace at service.sap.com/instguides under [ SAP
Business Suite Applications » SAP Event Management » Using SAP Event Management <version number> 3.
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7 Troubleshooting

SAP Event Management has no solution-specific troubleshooting tools.
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8 Services for SAP Event Management

You can find an overview of all services provided for SAP Event Management and its related components on SAP
Service Marketplace at www.sap.com/services and at service.sap.com/safeguarding.

The SCM Focus Group offers technical consulting services such as Administration, Monitoring, and Backup and
Recovery concepts for SAP SCM systems. You can find a detailed list of the services, as well as all contact
persons, in the SCM Focus Group Fact Sheet at [p service.sap.com/scm » SAP SCM in Detail » Technology »
Technical Consulting 1.
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9 Support Desk Management

Support Desk Management enables you to set up an efficient internal support desk for your support organization.
It seamlessly integrates your end users, internal support employees, partners, and SAP Active Global Support
specialists with an efficient problem resolution procedure.

For support desk management, you need the methodology, management procedures, and tools infrastructure to
run your internal support organization efficiently.

Support desk management covers the following topics:
® Remote Support Setup

® Problem Message Handover

9.1 Remote Support Setup

SAP support needs to work remotely for the highest levels of efficiency and availability. Therefore all required
support tools must be remotely accessible for SAP support. For SAP Event Management, the standard SAP
procedures for setting up remote support apply.

SAP Notes for Special Remote Connection Types

Table 12
812732 R/3 Support Service Connection
592085 Installing the HTTP Connect service
605795 Windows Terminal Server connection in remote support
100740 Setting up a PCanywhere connection in the SAP front end
37001 Telnet link to customer systems
1 Note

With the exception of SAP Note 812732, you can use these connection types for issues relating to the user
interface.

For information about how to set up a SAProuter connection to SAP (SAPserv X), see SAP Note 35010.

9.2 Problem Message Handover

To send problem messages to SAP, use the following application components in the SAP application component
hierarchy.

e SCM-EM* - for general Event Management problems
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e BW-BCT-EM - for BW-related Event Management problems

1 Note
In the case of messages related to the user interface, attach screenshots that clearly explain the issue.

CUSTOMER
© Copyright 2015 SAP SE or an SAP affiliate company. SAP Event Management 9.2
30 All rights reserved. Support Desk Management



A Appendix

Al

Categories of System Components for Backup and

Restore
Table 13
Categories of System Category Properties Suggested Methods for Examples
Components Backup and Restore
| Only software, no ®  No backup, new BDOC modeler
configuration or application installation in case of a
data recovery
® |nitial software backup
after installation and
upgrade
®  Backup of log files
I Only software and ®  Backup after changes SAP Gateway

configuration information, no
application data

®  No backup, new
installation, and
configuration in case of
arecovery

®  Backup of log files

Comm. Station
SAP Business Connector

SAPIPC (2.0C)

Only replicated application
data, replication time is
sufficiently small for a

Data:
®  No data backup needed

®  Backup of software,

SAP IMS/Search Engine
SAPIPC (2.0B)

Webserver
recover
y configuration, and log
files SAPITS
I\ Only replicated application Data: SAP IMS/Search Engine
data, backup recommended | o  Appjication-specific file | Webserver
because replication time is system backup
too long, data not managed o
g g e  Multiple instances
by a DBMS
®  Backup of software,
configuration, and log
files
\ Only replicated application Data: SAP IPC (2.0B)

data, backup recommended e Database and log Catalog Server
because replication time is

backup
too long, data managed by a
DBMS e  Multiple instances
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Categories of System

Components

Category Properties

Suggested Methods for

Back

up and Restore

Backup of software,
configuration, and log
files

VI Original application data, Data: Webserver
standalone system, data not e Application-specific file
managed by a DBMS system backup
®  Backup of software,
configuration, and log
files
VII Original application data, Data: Not Available
standalone system, data e Database and log
managed by a DBMS, not backup
based on SAP NW AS
asedon ®  Backup of software,
configuration, and log
files
VI Original application data, Data: Standalone SAP
standalone system, basedon | ¢  Dpatabase and log ERP
SAPNWAS backup, application log
backup (such as job
logs in file system)
®  Backup of software,
configuration, and log
files
IX Original application data, Data: Not Available
data exchange with other e  Application-specific file
systems, data not managed system backup
by a DBMS
ya You must consider data
consistency with other
systems.
®  Backup of software,
configuration, and log
files
X Original application data, Data: SAP liveCache
data exchange with other e Database and log SAP Mobile
t dat db
systems, data managed by a backup Workbench
DBMS, not based on SAP NW :
AS You must consider data
consistency with other
systems.
®  Backup of software,
configuration, and log
files
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Categories of System Category Properties

Components

Suggested Methods for
Backup and Restore

Xl Original application data,
data exchange with other
systems, based on SAP NW
AS

Data: SAP ERP

® Database and log SAP CRM

backup, applicationlog | sap APO

back-up-(such as job SAPEBI
logs in file system)

You must consider data
consistency with other
systems.

®  Backup of software,
configuration, and log
files

A.2 Related Guides

For more information about installation and configuration, see the Master Guide.

A.3 Related Information

The following table contains links to information related to the Application Operations Guide:

Table 14

Master Guide, Installation Guide and Upgrade Guide

|F service.sap.com/instguides 3

Related SAP Notes

|# service.sap.com/notes 3

Released Platforms

|# service.sap.com/platforms 3

Network Security

|F service.sap.com/securityguide 3

Technical Infrastructure

help.sap.com/netweaver

Select the version of SAP NetWeaver, and choose Security
Information.

SAP Solution Manager

| service.sap.com/solutionmanager 3

SAP Event Management 9.2
Appendix
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